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Design and shape the world around you with the powerful, flexible features found in AutoCAD
®
 

software, one of the worldôs leading 2D and 3D design applications. With robust 3D tools that can create 

almost any shape imaginable, AutoCAD helps you intuitively explore design ideas. It offers innovations 

that can increase design and documentation efficiency, and enables you to more securely, accurately, and 

seamlessly share those designs with colleagues. Powerful programming tools and thousands of available 

add-ons provide the ultimate in flexibility, helping you customize AutoCAD software for your specific 

needs. With these capabilities and more, AutoCAD delivers the power and flexibility needed to take 

documentation and design further. 
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Introducing AutoCAD 2012 
New and expanded workflows for model documentation, reality capture, and 3D conceptual design help 

increase productivity with AutoCAD 2012. Explore your design ideas with powerful surface modeling 

tools. Quickly create documents from a variety of modeling formats, helping to reduce manual 

documentation workarounds. Capture and import as-built information to jumpstart your design process. 

Plus, youôll find a wide range of timesaving enhancements to the features you use most. AutoCAD 2012 

delivers the powerful tools you need to participate in smooth 3D design workflows, helping drive your 

projects to completion more quickly than ever before. 

User Interaction and Modernization  
AutoCAD 2012 enhances the way you interact with the software from concept through completion. With 

noticeable improvements to performance, expanded online resources, and fast, intuitive access to 

commands and editing tools, you will spend less time focusing on the software and more time advancing 

your designs.  

Performance Improvements 

AutoCAD 2012 offers improved performance in many areas. Enjoy faster startups, particularly when 

running on Windows Vista
®
 or Windows

®
 7. Inside AutoCAD 2012, youôll discover nearly instantaneous 

response as you switch between ribbon tabs. AutoCAD 2012 also offers improved performance when 

opening large 3D models with lofts and meshes and when orbiting large 3D models. Additional 

performance improvements can be found with selection highlighting, licensing checkout, and when 

running LISP routines.    

Autodesk Content Explorer 
Quickly find design content based on file objects or text attributes. The Autodesk

®
 Content Explorer

TM
 

functionality creates an index of your data based on where you instruct it to look, helping you quickly 

access files. You can explore, or browse into, DWG
TM

 files in order to access and insert blocks, layers, 

linetypes, styles, and more. Unlike the Design Center tool, Content Explorer is built on a Google
®
-like 

index, so you can quickly search for design objects across folders containing thousands of files; the 

results appear instantaneously. In addition, Content Explorer provides a single interface for browsing and 

searching other content sources, such as Autodesk® Seek web service. 

 

Easily access Content Explorer with the Explore tool on the Plug-ins ribbon tab.  

 

In the Content Explorer window, use the Search field to find design content on your local computer, one 

or more network locations, and the Autodesk Seek site. A pull-down menu allows you to choose from the 

available locations.  
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You can locate specific block references or text strings, including block attribute data. Quickly determine 

how many references there are in a file or find a particular reference across multiple files. Easily drag 

content from the Content Explorer window into your current drawing. You can also right-click or double-

click content in the Content Explorer window to automatically open the source file and zoom into relevant 

objects such as text. 

 

You can expand and collapse each panel in the search results to easily view all the results. Control the 

type of content and the format in which it is displayed using the Filter Settings and View Options tools in 

the lower right corner of the Content Explorer. 



6 

 

www.autodesk.com/autocad  

 

 

For example, you can filter content so your results show only the specific object types you are interested 

in. Switch between thumbnail and detail views, specify the icon size, group the results in various ways, 

and choose whether or not to display text labels and column headers. 

      

The Content Explorer searches for content in specified locations that are included in an index. Their 

activity is continually monitored by the Content Service, which is installed with AutoCAD, and the index 

is automatically updated to reflect changes. By default, the search index includes the AutoCAD Sample 

and Downloaded Content folders as well as the Autodesk Seek site. You can easily add your own local 

and network content to the index. 

Local Content 

Add your own local folders to the Content Explorer index using the Add Watched Folder option at the 

bottom of the Content Explorer window or by dragging folders from Windows Explorer to Content 

Explorer. The folders are not moved or copied; theyôre simply added to the search index.  
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Network Content 

In addition to searching content on your local computer, Content Explorer can also search one or more 

network computers. However, it requires the Content Service to run on the network computers and build 

an index on that machine. This provides a single index that all clients can access and search. Therefore, in 

order to support searching on network drives, software needs to be installed separately on the network 

computer. This software, called Autodesk Content Service, is available from your AutoCAD 2012 

installer under Tools and Utilities. Make sure this program is checked; then install it on one or more 

network computers. 

     

Once the Content Service is installed on the network computer, you can add one or more network folders 

to be watched. Adding watched folders enables the content service to build an index for the files in those 

folders. The key difference between watched folders on the local machine and watched folders on the 
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network computer is that on a network computer watched folders need to be shared folders in order for 

AutoCAD users to be able to access and search them. To add network shares as watched folders, launch 

the Content Explorer Console, which is located in the Windows Start menu under All Programs > 

Autodesk > Content Service>Content Service Console. When you choose Add Watched Folder, youôll 

notice that only shared folders are available to select. 

 

After Autodesk Content Service has been installed on one or more network computers, and  watched 

folders have been configured, you can add these network locations as content sources within Content 

Explorer in AutoCAD. In the lower right corner of the Content Explorer window, choose Configure 

Settings to display a dialog box with various content sources that you can search and access. Then, in the 

lower left corner of the Configure Settings dialog box, choose Add Network Content. Simply specify the 

computer name or IP address of the network computer (for example, \\serv1230001, 10.23.58.88). 

 

The network content is easily searchable from the Content Explorer and, thanks to indexing, produces 

quick results. 

 



9 

 

www.autodesk.com/autocad  

 

Autodesk Seek Content 

In Content Explorer, you can use the Autodesk
®
 Seek web service to browse and search for online 

content. Find files by manufacturer or via product specs, and insert files directly into your drawing 

without navigating to an external website. 

 

User Interface 
The updated user interface makes it easier than ever to identify and access frequently used tools. The 

Home tab includes changes in the Draw and Modify panels. 

 

The Insert tab now has Block and Block Definition panels. The tools related to inserting and editing block 

references are grouped together and the tools to create or edit block definitions are grouped together. 

Wblock is included in the Create Block flyout. The View tab includes a new Forward tool and a 

Rectangular viewport option has been added to the Viewports panel. 
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AutoComplete Command Entry 
AutoCAD 2012 now offers auto-complete options to help you access commands more efficiently. As you 

type in the Command prompt (or use dynamic input), AutoCAD automatically completes the entry with 

an AutoCAD command or command alias. If you pause, it displays a list of all the commands whose 

prefix matches what youôve typed, enabling you to scroll and select from the list.  

         

A right-click menu provides easy access to the new AutoComplete controls, including the ability to 

display system variables and specify the delay response for displaying the AutoComplete list. 

           

In the Command window, the command history is distinguished from the active command line with a 

grey background color. You can modify the various colors associated with the command window using 

the Drawing Window Colors dialog box, which is accessible from the Display tab of the Options dialog 

box. 

Multifunctional Grips 
The power of multifunctional grips has been extended to more AutoCAD objects, including lines, arcs, 

elliptical arcs, dimensions, and mleaders, as well as 3D faces, edges, and vertices. Access relevant options 

for the selected object by hovering the cursor over a grip.  
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Using multifunctional grips with dynamic input turned on allows you to edit the object via relevant 

dimensional values. For example, when you choose the Lengthen option for a selected line, dynamic input 

dimensions for the total length and the incremental length are displayed. You can use the Tab key to 

switch between the two values. Similarly, elliptical arcs have been updated to support dynamic input for 

the major and minor axes. When you hover the cursor over a quadrant grip with dynamic input enabled, 

the distances from the center to the quadrants are displayed along the major and minor axes. If you click 

on the grip, you can edit the values. 

         

Nudge Functionality 

New Nudge functionality is useful when you need to move selected objects a few pixels in an orthogonal 

direction. Simply press Ctrl and the appropriate arrow key. 

Quick Properties 

Use the Quick Properties tool (QP command alias) to view and modify properties of a selected object. 

The Quick Properties window is automatically displayed when you double-click on most objects. Itôs 

automatically dismissed when the selection set is cleared and doesnôt come back until you launch the 

command again. The default list of quick properties has been updated to include more frequently used 

properties.   

 

Object Selection  

Object Groups 

Group functionality has been streamlined in AutoCAD 2012 making it easier to use. You can access the 

new Group tools from the Group panel on the Home ribbon tab.    
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The Group tool replaces the traditional Object Grouping dialog box with a simple prompt to select 

objects. You have the option of providing a group name and description. The Ungroup tool ungroups the 

objects. You can use the Edit Group tool to add and remove objects or to rename the group. These tools 

are also available from the right-click menu when a group is selected. 

A Group Selection toggle allows you to control whether objects are selected individually or as a group. 

Expanding the Group panel provides access to additional Group tools. The Group Bound Box controls 

how groups are displayed. When itôs enabled, AutoCAD displays a single grip and a bounding box 

around the group. The Named Groups tool displays the classic Object Grouping dialog box. 

 

The Purge tool has been updated to support the purging of groups that contain no objects. 

Implied Selection 

Pick variables offer more flexibility and control when selecting objects. When you pick the first point of 

an implied window, you now have the ability to use a Wpolygon, Cpolygon, and Fence in addition to the 

traditional window selection method. And you no longer have to choose between picking two points or 

picking and dragging to determine the selection window. The PICKDRAG system variable includes a 

new option (PICKDRAG=2) that combines both of these methods. The PICKAUTO system variable 

includes a new option (PICKAUTO=2) that allows you to start a window or crossing selection even when 

picking on an object. This minimizes the need for you to find a ñcleanò spot for picking.  
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Snap Mode 

When Snap Mode is on, the cursor no longer snaps to grid points when selecting objects, but does so only 

when specifying points. 

External Reference Enhancements 

AutoCAD 2012 improves the ability to highlight and select externally referenced files. If you pass the 

cursor over the edge of an attached image, DWF
TM

, or PDF file, a selection preview frame is displayed, 

even when frames are turned off. 

 

Similarly, passing the cursor over geometry inside an attached DWF, PDF, DGN, or DWG file displays a 

selection preview frame. You can select the frame for any of the attached reference files to display a 

frame boundary, with the ability to grip-edit a clipped boundary frame. 

Interaction with the External References manager is enhanced to automatically display the frame when 

you select a reference file from the list. 

To support the frame selection behavior, a new FRAMESELECTION system variable is included in 

AutoCAD 2012.  

Autodesk ExchangeïAutoCAD 

With connected access to getting started videos, downloadable plug-ins, and help content, the Autodesk
®
 

Exchange feature brings the content you need directly to your AutoCAD workspace. Autodesk Exchangeï

AutoCAD is first displayed when you start AutoCAD 2012. A toggle in the lower left corner of the window 

allows you to disable it on startup but you can access it at any time from the Infocenter in the upper right 

corner of the AutoCAD window. The Exchange button displays Autodesk Exchange with the Home tab 

active, and the Help button displays it with the Help tab active. 
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Explore 

In-Canvas Viewport Control 

New viewport controls enable you to change viewport settings, views, and visual styles directly on the 

viewport canvas.  

 

The 3D Modeling tab of the Options dialog box includes controls for displaying the in-canvas viewport 

controls.  

 

You can specify the color of the viewport control in the Drawing Window Colors dialog box, which is 

accessible from the Display tab of the Options dialog. 
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UCS Enhancements 
AutoCAD 2012 provides many enhancements that make the UCS faster and easier to use. 

The UCS icon has been updated to allow direct manipulation. You can select the UCS icon and then use 

the multifunctional grips to change the UCS. Easily move the origin, and automatically align the UCS 

with objects, including curved surfaces and solids.  

                   

You can rotate the UCS around the X, Y, or Z axis using grips, and without having to access the UCS 

command.  

 

When the UCS icon is selected, relevant options are displayed in the Properties palette. 
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A new control on the Settings tab of the UCS dialog box enables you to specify whether the UCS icon is 

selectable. You can access the UCS dialog box from the Coordinates panel of the View ribbon tab when 

the 3D Modeling workspace is active. 

Easily access additional UCS controls from a shortcut menu by right-clicking over the UCS Icon. You 

can modify the shortcut menu to meet your needs using the Customize User Interface dialog box. 

          

When you access the UCS through the UCS command, AutoCAD 2012 displays a dynamic preview of 

the UCS icon, making it easier to understand and provide needed feedback for UCS options.   
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3D Associative Array 
The associative array functionality that is so valuable for 2D documentation is equally useful for 3D 

modeling. Each of the three types of associative arraysðrectangular, polar, and pathðinclude the ability 

to array selected objects in 3D space. Use the Level option to specify the number items in the Z direction 

during or after array creation.  

                                          

Whether you create one- or multiple levels of array objects, you can specify an increment value for row 

elevation. When the row elevation increment is set to zero, as it is by default, all rows are created at the 

same elevation. When set to any other value, positive or negative, the elevation of each row is 

incremented by that amount. 

 

When creating a path array, you can specify whether the arrayed objects should maintain a vertical 

orientation (Z direction) or adjust to remain parallel to the path. 
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Creation Preview 

A new preview provides a visual cue indicating when a surface or solid is in an intermediate state during 

creation. For example, as you select profiles to create a lofted solid or surface, an updated preview of the 

resulting object is displayed with each selection.   

 

In addition to solid and surface lofts, the preview is included with the following commands: 

SURFBLEND, SURFPATCH, SURFFILLET, FILLETEDGE, CHAMFEREDGE, and LOFT. The 

preview displays with a transparency to easily distinguish it from completed objects. You can control the 

transparency level with the new PREVIEWCREATIONTRANSPARENCY variable.   
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Chain and Loop Selection 

AutoCAD 2012 includes new Chain or Loop options to simplify the process of selecting a set of 

contiguous edges or curves. 

The new Chain selection option detects if there is a set of contiguous edges within a solid or mesh object, 

or within or between surfaces. The chain may either be open or closed and is available in the 

SURFPATCH, SURFBLEND, MESHCAP, and FILLETEDGE commands. 

 

The Chain option within the FILLETEDGE command identifies and fillets edges that have continuity. For 

example, the part below on the left does not have rounded corners so the fillet operation is limited to the 

selected edge. The part on the right, however, has rounded corners enabling the Chain option to select and 

fillet all the continuous edges.  
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In addition to the Chain option, the FILLETEDGE and the CHAMFEREDGE command include a Loop 

option. A loop is similar to a closed chain. After selecting an edge, you can choose which of the potential 

loops to use.     

 

Offset Edge 
The new Offset Edge tool, available on the Solid Editing panel, enables you to create an offset curve from 

a planar face or from a surface where all the edges lie on the same plane. After you select a face, the edge 

of the face is dynamically offset to the inside or outside based on cursor location producing a polyline or 

spline. During the offset operation, you can access the Corner option to specify sharp or rounded corners 

for the offset curve. After offsetting an edge, you can use the Presspull tool to easily add or remove the 

bounded area from a solid. 

 

Presspull Functionality 
Presspull functionality provides an easy way to create and edit solids. You simply click in a bounded area 

of a solid and AutoCAD dynamically creates an extruded solid. If the bounded area is the face of a solid, 

the extrusion is added or removed from the solid. In AutoCAD 2012, powerful Presspull functionality has 

been updated to repeat until you exit the command enabling you to quickly press and pull multiple times 

in a single operation. 
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Trimmed Surface Properties 

The Properties palette for trimmed surfaces is updated to provide more control and flexibility. A new 

Trims pane displays trim properties for the selected surface. It includes an Edge property, which cycles 

through the edges and highlights them in the drawing. The new Associative Trim property indicates if the 

current edge is associative. You can remove the associativity for any given edge. 

   

3D Autosnap Marker 

The Autosnap Marker control in the Drawing Window Colors dialog box is renamed to 2D Autosnap 

Marker and a new 3D Autosnap control was added. With different colors, you can more easily distinguish 

between 2D and 3D osnaps in the drawing editor.  
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Solid History 
Solid history is turned off by default in AutoCAD 2012. With solid history turned off, you can directly 

edit faces, edges, and vertices of solids. To retain solid history, you can set the SOLIDHIST system 

variable to 1. 

3Dconnexion Support 

Support for 3Dconnexion devices is improved in AutoCAD 2012. The precision and controllability of 3D 

mouse movements were further optimized to provide a more superior 2D and 3D navigation experience. 

In Walk and Fly modes, the navigation speed accelerates as the camera position moves away from the 

model. With Object mode, a consistent zoom speed is maintained regardless of the model size or position 

of the camera within the drawing.    

Autodesk Fusion 
Autodesk

®
 Inventor

®
 Fusion adds to the 3D conceptual design capabilities of AutoCAD and sets a new 

standard for professional 3D modeling ease of use. It enables you to flexibly edit and validate models 

from almost any source, helping you further experience the benefits of accessible 3D in the native DWG 

format. Inventor Fusion showcases intuitive direct manipulation capabilities, provides direct modeling for 

rapid design changes, and unites direct and parametric workflows within a single digital model. 

 

When installing AutoCAD 2012, you have the option to install Autodesk Inventor Fusion 2012.  
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If you choose to install Fusion, you will find an Edit in Fusion tool on the Plug-ins ribbon tab in 

AutoCAD 2012.  

 

 

You can use this tool to select any of the following 3D objects in your AutoCAD drawing to 

automatically open it for editing in Autodesk Inventor Fusion: 

¶ 3D Solid 

¶ Extruded Surface 

¶ Lofted Surface 

¶ Planar Surface 

¶ Swept Surface 

¶ Revolved Surface 

¶ NURBS Surface 

You will also find the Edit in Fusion option on the right-click menu whenever one of those objects is 

selected. 


































































